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C»zvµÛ¯À Â›uõÒPÒ

   

 C¨ £õhzøuU PØÓ¤ßÚº }[PÒ,

  •	 Â›uõÎß Ai¨£øh Á\vPÒ ©ØÖ® ö\¯Ø£õkPÒ

•	 £ozuõÎß TÖPÒ 

•	 £ozuõÎÀ uµÄPøÍ Em¦Szu¾® JÊ[Pø©zu¾®

•	 C»S Pozu¾US›¯ ö\´øPPÒ  ö£Ö©õÚ[PøÍ¨ £¯ß£kzva 

`zvµ[PøÍ E¸ÁõUSuÀ

•	 `zvµ[PøÍ GÊxÁuØS P»•PÁ›PøÍ²®,  \õº¦PøÍ²® 				 

£¯ß£kzuÀ

•	 £ozuõÒPøÍ JÊ[S£kzuÀ

•	 \õº£õÚ ©ØÖ® \õº£ØÓ P»•PÁ›PøÍ¨ £¯ß£kzuÀ

•	 Áøµ¦PøÍ u¯õ›zuÀ 

  Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

 7.1  C»zvµÛ¯À Â›uõÒPÒ 

	 ©UPÍx  AßÓõh  P¸©[PÐUS  ©mk©ßÔ  öuõÈÀŸv¯õÚ ÷uøÁ

PÐUS® £À÷ÁÖ PozuÀPøÍa ö\´Áx AÁ]¯©õS®. C¢uU 

PozuÀPøÍa ö\´ÁuØS ©UPÒ £À÷ÁÖ E£õ¯[PøÍ¨ £¯ß£kzxQßÓÚº. 

Pozu¾UPõÚ ¤µa]Ú[PÎß ußø©PøÍ¨ ö£õÖzx £À÷ÁÖ •øÓPÒ 

øP¯õÍ¨£kQßÓÚ. PozuÀPÐUöPÚ ©Úøu²® ÂµÀPøÍ²® E£÷¯õ 

QUQßÓÚº. ]UP»õÚ PozuÀPøÍz wº¨£uØS  GÊvwºzuÀ AÀ»x 

PozuØ ö£õÔPÒ £¯ß£kzu¨£kQßÓÚ. GÛÝ®, C¢uU PozuÀ £oPøÍ 

ö\®ø©¯õPÄ® C»SÁõPÄ® ö\´ÁuØöPÚ C»zvµÛ¯À Â›uõÒPøÍ 

GÆÁõÖ £¯ß£kzu»õö©ß£x £ØÔ AÔ¢xöPõÒ÷Áõ®. 

E¸   7.1

7
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	 •øÓ¯õPÄ®, GÊzx ‰»•® PozuÀPøÍa ö\´ÁuØPõP Pouz 

uõÒPøÍ £¯ß£kzxÁx G©x ÁÇø©¯õS®. CzuõÒPÒ {ø»USzx 

{µÀPøÍ²® Qøh¯õÚ {øµPøÍ²® öPõskÒÍÚ.    Cuß  Ai¨£øh°÷»÷¯ 

ö£Ö©ÍÄ {µÀPøÍ²®  {øµPøÍ²® öPõsh C»zvµÛ¯À  Â›zuõÒPÒ 

Aø©UP¨£mkÒÍÚ.

	

	 C»zvµÛ¯À Â›uõÒPøÍ¨ (Electronic Spreadsheets) £¯ß£kzxÁuß 

‰»® ¤ßÁ¸® £oPøÍ ªP C»SÁõPÄ® ÷|ºzv¯õPÄ®  ö\®ø©¯õPÄ® 

ö\´¯•i²®.

²	 C»SÁõÚx® PiÚ©õÚx©õÚ PozuÀPøÍa ö\´uÀ

²	 Áøµ¦PÒ ‰»® uµÄPøÍ ÂÍUSuÀ

²	 uµÄPøÍ JÊ[S¨£kzvU PõmkuÀ

²	 ÷uøÁ¯õÚ uµÄPøÍ ©õzvµ® ¤›zöukzuÀ

²	 uµÄPÎß |®£Pz ußø©°øÚ £›^¼zuÀ

²	 PhÄaö\õÀø»¨ (Password) £¯ß£kzv uµÄPøÍ¨ £õxPõzuÀ

7.1.1  C»zvµÛ¯À Â›uõÒ ö©ßö£õ¸ÒPÒ

	 £À÷ÁÖ ö©ßö£õ¸Ò EØ£zv {ÖÁÚ[PÒ ‰»® E¸ÁõUP¨£mkÒÍ 

C»zvµÛ¯À Â›uõÒ ö©ßö£õ¸ÒPÒ  £» AmhÁøn 7.1 CÀ Põmh¨ 

£mkÒÍÚ.

             ö©ßö£õ¸ÒPÒ 	               EØ£zv {ÖÁÚ[PÒ

                    Excel 2010           Microsoft Comporation
                    Numbers           Apple Inc
                    LibreOffice Calc           The Document Foundation 

Open office Calc           Apache Foundation
            AmhÁøn 7.1 £À÷ÁÖ ö©ßö£õ¸Ò ÁøPPÐ® AÁØÔß EØ£zv {ÖÁÚ[PÐ®.	 

	   

7.1.2  Â›uõÒ ö©ßö£õ¸ÒPøÍa ö\¯Ø£kzxuÀ

 	 Â›uõÒ ö©ßö£õ¸ÒPÎÀ  Microsoft  Office  2010  ©ØÖ®  LibreOffice Calc 
BQ¯ ö©ßö£õ¸PÒ £ØÔ ©õzvµ÷© C¨£Sv°À P»¢xøµ¯õh¨£kQßÓx. 

ö©ßö£õ¸ÒPøÍz öuõÈØ£ha ö\´²® •øÓPÒ AÁØÔß ö\¯Ø£õmk  

•øÓø©PÎß Ai¨£øh°À ÷ÁÖ£h»õ®. 

	 Microsoft Office EØ£zvPÒ  AÝ©v¨£zvµzxhß öPõÒÁÚÄ   ö\´¯¨£h 

÷Ásk®. LibreOffice EØ£zvPøÍ C»Á\©õP¨  £¯ß£kzu •i²®.
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Microsoft Office Excel 2010 CÀ

Start → Programs→ Microsoft 
Office→	Microsoft Office Excel 2010

LibreOffice Calc CÀ

Start → Programs → Libre Office Calc 
→LibreOffice Clac

    7.1.3 Microsoft Excel 2010 Cß Cøh•P•® Auß TÖPÐ®

10' kdu fldgqj

    Name Box

6' ö\¸SuÀ

      (Insert) 

 7' {ÖzuÀ

  {ø» (Tab)
8' `zvµ¨ £møh    

  (Formula Bar) 9' {µÀPÎß 

uø»¨¦ 

(Column Headings)

1' AÁ\µ Em¤µ÷Á\ E£µPµn¨              

 £møh (Quick Accese Tool Bar)   2'uø»¨¦¨ £møh

   (Title Bar)   3' |õhõ

     (Ribbon)
4'EuÂ

  (Help)

 5.Pmk¨£õmk¨ 

   ö£õzuõßPÒ   
    (Control Buttons) 

12' C¯US P»® 

     (Active Cell) 

13' Á›ø\z uø»¨¦

     (Row Heading) 

14' £ozuõÒ      

      {ÖzuÀ

  {ø»    
(Sheet Tab)

11' }Ò_¸Ò £møh

     (Verticle Scroll Bar)

15' Qøh_¸Ò £møh

     (Horizontal Scoll Bar)

19' E¸ Pmk¨£õmk 

           P¸Â 

    (Zoom Control)

E¸   7.2  Microsoft Excel 2010  Cß Cøh•P®

18' Põm]£kzuÀ

     ö£õzuõß 
     (View Buttons)

17'{ø»ø©¨

   £møh

    (Status Bar)

16' £ozuõÒ

      ÁÈ   

    PshÔuÀ

    ö£õzuõß

    (Sheet Tab 
     Scroll Button)

10' ö£¯º ö£mi-

Name   box 
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           EÒÍhUP®                   ÂÁµ®

1'   AÁ\µ Em¤µ÷Á\ E£Pµn¨ 

£møh

Save, Print Preview, Undo, New ÷£õßÓ 

AiUPi ÷uøÁ¨£k® E£Pµn[PøÍ¨ 

ö£ØÖUöPõÒÍ EuÄ®

2'   uø»¨¦¨ £møh ö©ßö£õ¸Ò EÒÏmk¨ ö£¯øµU 

Põm]¨£kzuÀ

3'   |õhõ Home, Insert, Page layout  ÷£õßÓ 

E£Pµn[PøÍU Põm]¨£kzuÀ

4'   EuÂ EuÂPøÍ¨ ö£ØÖUöPõÒÍ EuÄ®

5'   Pmk¨£õmk AÊzxøP £ozuõÒ \mhzvøÚ Â›Ä¨£kzuÀ 

_¸USuÀ ©ØÖ® ‰iÂkuÀ

6'   ö\¸SuÀ `zvµ[PøÍ E¸ÁõUSÁuØS AÁ]¯©õÚ 

SÔ±mk •P¨¤øÚ¨ ö£ØÖUöPõkzuÀ

7'   {ÖzuÀ {ø» |õhõøÁ ©õØÓ EuÄ®

 8.   `zvµ¨ £møh `zvµ[PøÍ öÁÎ¨£kzxÁuØS® 

P»[PÎß EÒÍhUPzøu öÁÎ¨£kzuÄ® 

EuÄ®

9.    {µÀPÎß uø»¨¦ {µÀPÎß uø»¨¦UPøÍ öÁÎ¨£kzx®

10. ö£¯ºU Tk ö\¯Ø£õmkU P»zvß •PÁ›°øÚ 

öÁÎ¨£kzx®

11. }Ò_¸m £møh £ozuõøÍU Qøh¯õPU Põm]¨£kzu EuÄ®

12. C¯US P»® uµÄ Em£kzu ÷Ási¯ P»zøuU Põmk®

13. Á›ø\z uø»¨¦ Á›ø\ C»UPzøuU Põmk®

14. £ozuõÒ {ÖzuÀ {ø» £ozuõøÍ¨ ¤µv{vzxÁ¨£kzx®

15. Qøha_¸m £møh £ozuõøÍ ö\[SzuõPU Põmh EuÄ®

16. £ozuõÒ ÁÈPshÔuÀ

      ö£õzuõß

£ozuõÒPøÍ ©õØÖÁuØS EuÄ®

17. {ø»ø©¨ £møh £ozuõÐhß Cøn¢u {ø»ø©PøÍU 

Põm]¨£kzx®

18. Põm]¨£kzuÀ  ö£õzuõß £ozuõÒ Põm]¨£k® ÂuzvøÚ 

öÁÎ¨£kzx®

19.  E¸ Pmk¨£õmkU P¸Â £ozuõÒPøÍ Â›ÁõUSÁuØS AÀ»x 

_¸UQ¨ £õºUP EuÄ®

AmhÁøn   7.2  Microsoft Excel  Cß TÖPÒ
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3' {¯©U P¸Â¨£møh 
    (Standard Tool Bar)

2'£mi¯À £møh                                                                                                                                             
  (Menu Bar)

1'uø»¨¦¨ £møh

   (Title Bar)

5' ö£¯º ö£mi   	

   (Name Box)

9' C¯[S P»® 

   (Active Cell) 

6'ö\¸SuÀ (Insert)	

7' `zvµ¨ £møh   

  (Formula Bar) 11' }Ò_¸Ò £møh

    (Vertical Scroll Bar)

13' Qøha_¸Ò£møh

   (Horizontal Scroll Bar)

16' {ø»ø©¨ £møh  
     (Status Bar)

15'  £ozuõÒ ÁÈ  

     PshÔuÀ ö£õzuõß

      (sheet Scroll Button)

E¸ 7.3  LibreOffice Calc   Cß  Cøh•P®

12' Á›ø\z uø»¨¦ 

     (Row Heading) 

17'Pmk¨£õmkU    

   P¸Â (Zoom Control)

4' Pmk¨£õmk ö£õzuõßPÒ 
   (Control Buttons)

8. ÁiÁø©¨¦U P¸Â¨£møh

         (Formating Tool Bar)

14'  £ozuõÒ {ÖuÀ {ø»

      (Sheet Tab)

10'Á›ø\zuø»¨¦ 

  (Column Heading)

           EÒÍhUP®                   Â£µ®

1'  uø»¨¦¨ £møh ö©ßö£õ¸Ò EÒÏk ö£¯øµU Põm]¨£kzuÀ

2'  £mi¯À £møh ¤µuõÚ PmhøÍPøÍU Põm]¨£kzx®

3'  uµU P¸Â¨ £møh {¯©U P¸ÂPøÍ öu›¯ Põm]¨£kzx®

4'  Pmk¨£õmk ö£õzuõß £ozuõÒ \mhzvøÚ Â›Ä¨¦kzuÀ _¸USuÀ 

©ØÖ® ‰iÂkuÀ

5'  ö£¯º¨ ö£mi ö\¯Ø£õmkU P»zvß Â»õ\zøu 

öÁÎ¨£kzx®

6'  ö\¸SuÀ `zvµ[PøÍ E¸ÁõUSÁuØS AÁ]¯©õÚ 

SÔ±mk •P¨¤øÚ Põm]¨£kzx®.

7'  `zvµ¨ £møh	 `zvµ[PøÍ öÁÎ¨£kzxÁuØS® P»[PÎß 

EÒÍhUPzøu öÁÎ¨£kzuÄ® EuÄ®. 

8'  ÁiÁø©¨¦U P¸Â¨ £møh £ozuõÎøÚ ÁiÁø©UP EuÄ®

9'  {µÀPÎß uø»¨¦ uµÄ Em¦Szu ÷Ási¯ P»zøuU Põmk®

7.1.4  LibreOffice Calc 4.1 Cß Cøh•P•® Auß TÖPÐ®
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10' {µÀPÎß uø»¨¦ {µÀPÎß uø»¨¦UPøÍ öÁÎ¨£kzx®

11' }Ò_¸Ò £møh £ozuõøÍ Qøh¯õP Põm]¨£kzx®

12' Á›ø\z uø»¨¦ Á›ø\ C»UPzøu Põmk®

13' Qøha _¸Ò £møh £ozuõøÍa ö\[SzuõP Põmk®

14' £ozuõÒ {ÖzuÀ {ø» £ozuõøÍ¨ ¤µv{v¨£kzx®

15' £ozuõÒ ÁÈPshÔuÀ 

    ö£õzuõß

£ozuõÒPøÍ ©õØÖÁuØS EuÄ®.

16' {ø»ø©¨ £møh £ozuõÐhß Cøn¢u {ø»ø©PøÍU 

Põm]¨£kzx®

17' E¸ Pmk¨£õmkU P¸Â £ozuõÒPøÍ Â›ÁõUSÁuØS AÀ»x _¸UQ¨ 

£õºUP EuÄ®

                    AmhÁøn   7'3  LibreOffice calc Cß TÖPÒ

7.1.5  £ozuõÒ  (Worksheet)

	 C¸ £›©õnz uÍzvÀ {µÀPÒ (Columns) ©ØÖ® {øµPÒ ^Rows& GßÓ 

ÁõÖ Aø©¯¨ö£ØÓ P»[PÎß öuõS¨¦UPøÍU öPõsk £ozuõÒPÒ 

{¸©õoUP¨£mkÒÍÚ. CøÁ £ozuõÒ {ÖzuÀ {ø»PÒ (Sheet Tab) ‰»® 

öÁÎUPõmh¨£kQßÓÚ.
 

7.1.6  £ozuõÒPÎß {µÀPøÍ¨ ö£¯›hÀ

£ozuõÎÀ EÒÍ {µÀPÒ ¤ßÁ¸©õÖ B[Q»¨ ÷£öµÊzxUPÒ‰»®  

AÀ»x GÊzxzöuõSvPÒ ‰»® ö£¯›h¨£kQßÓÚ.  E¸ 7.4  I¨ £õºUPÄ®.

A, B, C, D,...... Z Áøµ²®

AA, AB, AC, AD, AE, ... AZ Áøµ²®

BA, BB, BC, BD, BF, ... BZ Áøµ²® GßÓÁõÖ ö£¯›h¨£k®.

7.1.7   £ozuõÒPÎß {µÀPøÍ ö£¯›hÀ

1, 2, 3, 4, 5, ... GßÓ Âu©õP÷Á £ozuõÎß {øµPÒ ö£¯›h¨£mi¸US®       

E¸ 7.4 I¨ £õºUP.

{øµPÒ

(Rows)
  {µÀPÒ

(Columns)

E¸ 7.4 £ozuõÎß {µÀPÒ, {øµPÎß Aø©¨¦
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ö£õxÁõP £ozuõÒ JßÔß {øµPÎß GsoUøP²® {µÀPÎß GsoU 

øP²® 2 Cß AkUS¨ ö£Ö©õÚ[PÎ÷»÷¯ Põn¨£kQßÓÚ.

Â›uõÒ ö©ßö£õ¸Ò	 	 {øµPÎß		  {µÀPÎß

					     GsoUøP		  GsoUøP	 	

Microsoft Excel 2003			  65536	 ^216&		  256 ^28&

Microsoft Excel 2007$2010		  1048576 ^220&		  16384 ^214&

LibreOffice Calc  4.1			  1048576 ^220&		  1024 ^210&

7.1.8   C¯UPU P»[PÒ (Active Cell) 
	

	 £ozuõÎÀ uµÄPøÍ EÒÎh •ßÚº E›¯ P»zvøÚz öu›uÀ 

÷Ásk®. AÆÁõÖ ÷uº¢öukUP¨£mh P»zvøÚ C¯[S P»® (Active Cell) 
GÚ AøÇUP¨£k®. R÷Ç Põmh¨£mkÒÍ E¸ 7.5 CÀ B3 C¯[S P»©õP 

CÚ[Põmh¨£mkÒÍx. C¯[S  P»©õÚx Ga\¢uº¨£zv¾® ui¨¤ß ‰»® 

GÀø»PøÍU Põmi {ØS®.

E¸  7.5  £ozuõÎÀ Põmh¨£mkÒÍ C¯[S P»®

 7.2  £ozuõÎÀ ö\¯Ø£hÀ

	 £ozuõöÍõßÔÀ uµÄPøÍ Em£kzu •ßÚº AuØS›¯ P»zøu 

C¯[Pa ö\´uÀ ÷Ásk®.

	 R÷Ç Põmh¨£mkÒÍ \õÂ/\õÂz öuõSvPøÍ C¯USÁuß ‰»® 

£ozuõÎÀ EÒÍ G¢uöÁõ¸ P»zvØS® £¯ozx C¯[Pa ö\´¯ •i²®.
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      \õÂ/\õÂz öuõSv                  ö£Ö÷£Ö

Arrow keys	 E›¯ vø\US (Ch®, Á»®, ÷©À, 

RÌ) P»® £¯oUS®

Ctrl  + Arrow Keys E›¯ vø\°À EÒÍ uµÄPøÍ 

Em¦SzuÀ CøhöÁÎ°ÝÒ E›¯ 

uµÂøÚ ÷|õUQ¨ £¯oUS®. 

Home C¯[S  P»®  C¸US®  {øµ°ß 

FhõP  A I ÷|õUQ {øµ°À £¯ 

oUS®

Ctrl + Home A1 P»zvøÚ ÷|õUQ¨ £¯oUS®

Ctrl + End uµÄ EÒÍ CøhöÁÎ°ß Á»¨£UP 

CÖvU P»zøu ÷|õUQ¨ £¯oUS®

Page Up £ozuõÎÀ, J¸ Á› ÷©»õP |P¸®

Page Down £ozuõÎÀ, J¸ Á› RÇõP |P¸®

 7.2.1  P» •PÁ›  (Cell Address)

	 •u»õÁx {µ¼ß GÊzøu²® CµshõÁx {øµ°ß C»UPzøu²® 

öPõsk P»zvØPõÚ ö£¯º Ch¨£k®. Cx  P»•PÁ› GÚ¨£k®. C¯[S 

P»zvß •PÁ›¨ ö£¯º ö£mi°À  D {µ¾® ‰ßÓõÁx Á›ø¯²® Cønzx 

P»® D 3 GÚ ö£¯›h¨£k®. (E¸  7.6 I¨ £õºUPÄ®.) 

ö£¯º ö£mi 

Name Box C¯[S P»®

Active Cell 

E¸ 7.6  £ozuõÎß P»•PÁ›
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 ö\¯Ø£õk 

	 KD74 GÝ® P»•PÁ› Aø©¢xÒÍ {µÀ .......... BÁ÷uõk 

{øµ ............ BS®.

 7.2.2  P»Ãa_  (Cell Range)

	 £ozuõÒ JßÔß £» P»[PøÍ CønzxU PõmkÁx P»Ãa_ 

GÚ¨£k®. R÷Ç Põmh¨£mkÒÍ £ozuõøÍ AÁuõÛUPÄ®.

E¸ 7.7  £ozuõÎÀ {µÀ FhõÚ 

Põmh¨£k® P»Ãa_

 				  

	 CU P»Ãa]À B2, B3, B4, B5  
BQ¯ |õßS P»[PÒ EÒÍhUP¨£m-

kÒÍÚ. P»Ãa_  B2 CÀ Bµ®¤zx 

B5 CÀ •iÁøh¢xÒÍx. C¢uU P» 

Ãa_ B2:B5 Áøµ Põmh¨£kQßÓx. 

J¸ {µ¼À Põmh¨£k® P»Ãa_ 

{øµ°ß C»UP[PÒ FhõP öÁÎ¨ 

£kzu¨£kQßÓx. E¸ 7.7 I¨ £õºU 

PÄ®

	 CUP»Ãa_ A3, B3, C3 GßÓ 

‰ßÖ P»[PøÍ EÒÍhUQ¯uõP 

Põn¨£kQßÓx.  CUP»Ãa_  A3 : C3
GÚ Põmh¨£kQßÓx. Á›°ÞhõP 

Põmh¨£k®     P»Ãa_,     Á›PÎß 

C»UPzvß Ai¨£øh°À •ßøÁU 

P¨£k® E¸ 7.8 I¨ £õºUPÄ®. E¸ 7.8  £ozuõÎÀ {øµö¯õßÔß FhõÚ 

P»Ãa_

	 C¨£ozuõÒ CøhöÁÎ B2, 
B3, B4, C2, C3, C4 GßÓ BÖ P»[PøÍ 

EÒÍhUQ²ÒÍx. CU P»CøhöÁÎ 

B2:C4 GÚ CÚ[Põmh¨£kQÓx.  {øµ 

©ØÖ® {µÀPÒ FhõP Aø©¢xÒÍ 

P»Ãa]ß {µÀ C»UP•® {øµ GÊzx® 

Âzv¯õ\¨£k®. E¸ 7.9 I¨ £õºUPÄ®.

 E¸ 7'9 £ozuõÎÀ {µÀ ©ØÖ® 

{øµPÒ Aø©¢xÒÍ P»Ãa_  
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SÔ¨¦ (    £ozuõÎß  P»Ãa_UPÒ  £»ÁØøÓ CÚ[PõmkÁuØS Põmh¨£k® 

Pmk¨£õmka \õÂ  (Control  key) £¯ß£kzu¨£kQßÓx. Cx 

Âø\¨£»øP°ß (Keyboard) Pmk¨£õmka \õÂ BS®.

  ö\¯Ø£õk

E¸ 7.10 Cß ‰»® Põmh¨£mkÒÍ £ozuõÎøÚ AÁuõÛzx 

R÷Ç uµ¨£mkÒÍ ÂÚõUPÐUS Âøh¯ÎUP.

^1&  R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ •u»õÁx P»zvß •PÁ› ¯õx?

^2& R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ P»zvß •PÁ› ¯õx?

^3& R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãaø\U SÔzxU PõmkP.

^4& R 2 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãaø\U SÔzxU PõmkP.

^5& Á› JßÔÝÒ EÒÍ Ãa_ ¯õx?

^6& {µÀ JßÔÝÒ EÒÍ Ãa_ ¯õx?

^7& R 3 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãaø\U SÔzxU PõmkP.

^8& R 3 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãaø\U Põmk® 

    P»[PÎß GsoUøPø¯²® •PÁ›°øÚ²® SÔ¨¤kP.

R1
R2R3

E¸ 7.10 £ouõÎÀ EÒÍ P» Ãa_PÒ
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  E¸ 7'11 - £ozuõÎß •P¨¦ Aøh¯õÍ® Ch¨£UP©õP Aø©uÀ

7.2.3  uµÄPøÍ EÒÎhÀ

	 Â›uõÎÀ uµÄPøÍ Ch •ßÚº E›¯ P»zvøÚ C¯[Paö\´uÀ 

AÁ]¯® Auß¤ßÚ÷µ uµÄPøÍ EÒÎh ÷Ásk®. J¸ P»zvÝÒ •P¨¦ 

Aøh¯õÍ¨ (Label) ö£Ö©õÚ[PÒ (Value) AÀ»x `zvµ[PÒ (Formula) 
÷£õßÓÁØÔÀ HuõÁx JßÖ EÒÎh¨£k®.  

1. •P¨¦ Aøh¯õÍ® (Label)
	 umha_ ö\´¯¨£mh GÊzxUPÒ (Letters), GsPÒ (Numbers),  Â÷\h 

SÔ±kPÒ (Special Symbols) ‰»® AÀ»x AÁØÔß ÷\º©õÚ® ‰»® ö£ØÖU 

öPõÒÍ¨£mh ö\õØöÓõhº (Text) •P¨¦ Aøh¯õÍ® GÚ¨£k®. ö£õxÁõP 

P»zvÀ Ch¨£UPzvÀ (Left Align) Cx  Aø©¢xÒÍx.  R÷Ç  Põmh¨£mkÒÍ 

E¸ 7.11 Cß  ‰»® Â›uõÒ JßÔÀ Põn¨£k® •P¨¦ Aøh¯õÍzvß 

©õv›ø¯ AÁuõÛUP •i²®. 

SÔ¨¦ :	 C[S öuõø»÷£] C»UP[PøÍ Em¦Szx®÷£õx R÷Ç 

Põmh¨£mkÒÍ  Âu©õP  P»[PÒ  öÁÎ¨£h©õmhõx.  öuõø»

                 ÷£] C»UPzvß •u»õÁx C»UP©õÚ §a]¯® Põm]¨£kzu¨£h 

©õmhõx. •P¨¦ Aøh¯õÍ®  •øÓ°À øÁzxU öPõÒÁuØS  

öuõø»÷£] C»UPzvøÚ Em¦Szuz ÷uøÁ¨£mhõÀ P» Ãa]

øÚ J¸ £¢v¯õP ©õØÔ Aø©UP  ÷Ásk®. P»[PøÍ JÊ[ 

Pø©¨£x  öuõhº£õP ¤ßÚº P»¢xøµ¯õh¨£k®.

2. ö£Ö©õÚ[PÒ

	 AÍÄŸv¯õÚ ö£Ö©õÚzøu²øh¯ uµÄ ö£Ö©õÚ[PÒ GÚ¨£k®. 

ö£õxÁõP ö£Ö©õÚ[PÒ P»zvß Á»x £UPzvÀ (Right Align) SÔUP¨£k®. 

E¸ 7.12  CÀ CuØPõÚ EuõµnzøuU Põn»õ®. 

ö£¯º

£Âzµß

©xñß

ªßÚg\À •PÁ›öuõø»÷£] Gs©õPõn®©õÁmh®

AìªÚõ

h¯Úõ

öPõÊ®¦

Psi

÷PPõø»

©õzuøÓ öuß

÷©À

©zv¯

\¨µP•Á madhukshan@gmail.com

asmina@hotmail.com

daina@live.com

pavithran@yahoo.com
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SÔ¨¦ ( £SÂ¯À ö£Ö©õÚ® JßøÓ Em¦Szx®÷£õx {øÓöÁsøn 

•u¼À  umha_¨ ö\´x J¸ CøhöÁÎ Âmk (Single Space) 
¤ßÚº «v¨ £Sv°øÚ umha_  ö\´¯÷Ásk®.

3. `zvµ[PÒ  (Formula)
	 Po¨¥kPøÍa ö\´ÁuØPõP \©ß (=) Aøh¯õÍzøu •u¼À 

Cmk ö£Ö©õÚ[PÒ, P»•PÁ› ©ØÖ® u\©uõÚ® Gß£ÁØøÓ Em 

¦Szv GÊu¨£k® SÔ±k `zvµ® GÚ¨£k®. £ouõÎß P»zvÝÒ 

`zvµö©õßÔøÚ  Em¦Szx®÷£õx  AuÞhõPU PnUQh¨£k® ö£Ö©õÚ® 

P»zvÝÒ  öuß£kÁ÷uõk  `zvµ® A¢ua `zvµÁ›°À öuß£k®. 

Euõµn® 1
A1  ©ØÖ®  B1 P»[PÎÀ EÒÍ ö£Ö©õÚ[PÎß  ö©õzu® C1 P»zvÀ ö£ØÖU 

öPõÒÍÀ (E¸ 7.13 I¨ £õºUP.) 

`zvµzvß ‰»® ö£Ó¨£mh ö£Ö©õÚ®.

`zvµÁ›

C1 P»zvØS Em¦Szu¨£mh `zvµ®

E¸  7.13  `zvµ® £¯ß£kzu¨£k® Âu®.

{øÓöÁs

u\©uõÚ®

£n®

  E¸ 7.12  £ozuõÎß •P¨¦ Aøh¯õÍ® Á»¨£UP©õP Aø©uÀ

÷|µ®

vPv

AÔÂ¯À ö£Ö©õÚ®

Ãu®

£SÂ¯À ö£Ö©õÚ®
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    7.3  `zvµ[PøÍ GÊu¨ £¯ß£kzu¨£k® PozuÀ SÔ±kPÒ

SÔ±kPÒ    Poua ö\´øPPÒ

+ TmhÀ

− PÈzuÀ

                               * ö£¸USuÀ

/ ÁSzuÀ

^ Á¾

     

	

SÔ¨¦ :
SÔ±kPÒ ö\¯Ø£h ÷Ási¯  JÊ[QøÚ Aøh¨¦PÒ Aø©zx 

÷ÁÖ£kzu •i²®. A¨÷£õx Aøh¨¦USÒ EÒÍ £Sv •u»õ 

ÁuõPU PoUP¨£k®.

Poua ö\´øPU SÔ±kPÒ ö\¯Ø£k® •ßÝ›ø© JÊ[S  (Operator 
Precedence)	

	 •u»õÁx	 ^ &

	 CµshõÁx	 ^
	 ‰ßÓõÁx	 * , /
	 |õßPõÁx	 + , − 

   7.3.1  GsPøÍ²® ö\´øPU SÔ±kPøÍ²® £¯ß£kzva ö\¯Ø£kz  

             u¨£k® GÎ¯ PozuÀ •øÓø©PÒ 

	 GsPøÍ²® ö\´øPU SÔ±kPøÍ²® £¯ß£kzv GÊu¨£mh C»S 

ÁõÚ `zvµ[PÒ ]» E¸ 7.4 ‰»® Põmh¨£mkÒÍÚ.

			 

      ö\´øP            `zvµ®         ö£Ö÷£Ö

TmhÀ  ^ + &            = 2+4              6

PÈzuÀ   ^ − &	            = 5−2              3

ö£¸USuÀ ^ * &            = 4*5             20

ÁSzuÀ ^ / &            = 12$6              2

Á¾U PõnÀ  ^^&	
	

           = 2^4             16

                         AmhÁøn  7.4  `zvµ[PøÍ GÊxuÀ

>

÷©¼¸¢x RÇõP •ßÝ›ø© SøÓÁøh²®
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	 `zvµö©õßÔÀ £» PozuÀ SÔ±kPÒ Põn¨£h»õ® AUSÔ±kPÒ 

JÊ[QÀ ö\¯Ø£k® ÂuzvøÚ AmhÁøn 7.5 ©ØÖ® AmhÁøn 7.6 ‰»® 

AÁuõÛUP •i²®. 

           ö\´øP `zvµ®        ö£Ö÷£Ö

     = 2+4*3       = 2+12            = 14
     = ^2+4&*3       = 6*3            = 18
     = 4*3^2       = 4*9            = 36
     = (4*3)^2       = 12^2            = 144

			 

Euõµn® = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5
wºUP¨£k® 

•øÓ
= 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

= 5¬2*9$6-3 = 5¬2*3^2$3 = 8/2*3-8¬5
= 5¬18$6-3 = 5¬2*9$3 = 4*3-8¬5
= 5¬3 - 3 = 5¬18$3 = 12-8¬5
= 8-3 = 5¬6 = 4¬5

Âøh = 5 = 11 = 9

 7.3.2  P»•PÁ›ø¯²® SÔ±kPøÍ²® £¯ß£kzv `zvµ[PøÍ E¸ÁõUSuÀ
	

	 P»•PÁ›ø¯²® SÔ±kPøÍ²® £¯ß£kzv ̀ zvµ[PøÍ GÊxÁuõÀ 

HØ£k®  •UQ¯ AÝT»® `zvµzvØS›¯ P»[PÎÀ ©õØÓ[PÒ {PÊ® 

ö£õÊx Po¨¤h¨£mh ö£Ö©õÚ[PÒ C¯À£õP÷Á  ©õØÓ©øh²®.

AmhÁøn  7.5 GÎ¯ `zvµ[PÎÀ Aøh¨¦USÔPøÍ ChÀ

SÔ¨¦ : Aøh¨¦USÔ £¯ß£kzu£hÂÀø»ö¯Ûß \©©õÚ ©mhzv¾ÒÍ 

ö£¸UPÀ ^ * &, ÁSzuÀ  ^ $ & BQ¯ ö\´øPPÐ® TmhÀ ^ + &, 

PÈzuÀ ^ − & BQ¯ ö\´øPPÐ® `zvµzvß Chx £UPzv¼¸¢x 

Á»x £UP©õP C¸US® JÊ[QÀ wºUP¨£k®.

  ö\¯Ø£õk

¤ßÁ¸® `zvµ[PøÍz  wº¨£uß‰»® QøhUS® ö£Ö©õÚ[ 

PøÍ GÊxP.

 ^1& = 6-4$2		  ^6& = 4¬5*2^3		  ^11& = 5$2¬1^3*4
 ^2& = 5*4¬3		  ^7& = 8$4*2		  ^12& = 3-4*3$2
 ^3& = 3¬4*5		  ^8& = -4$2¬2		  ^13& = 6$3*2^1-3
 ^4& = 2^5¬3		  ^9& = 1¬2^2*3		  ^14& = 3*^2¬4&$9¬1
 ^5& = 3¬5^2	        ^10& = 3*4$2		  ^15& = 2^3$^5-1^3&*5

AmhÁøn 7.6  GÎ¯ `zvµ[PÎÀ Aøh¨¦USÔPøÍ ChÀ
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Euõµn® 1

	 J¸ ö\ÆÁPö©õßÔß _ØÓÍÄ ©ØÖ® £µ¨£ÍÄ Gß£ÁØøÓU 

Po¨£uØS Auß }Í®, AP»® Gß£ÁØøÓ •øÓ÷¯ ö\ÆÁPö©õßÔß A2 

©ØÖ® B2 P»[PÎÀ Em¦SzuÀ ÷Ásk®. _ØÓÍøÁU  Põs£uØS  C2, C3, C4  
BQ¯ P»[PÎÀ ‰ßÖ öÁÆ÷ÁÓõÚ •øÓPÎ¾® £µ¨£ÍøÁU Põs£uØS 

D2 P»zv¾® E›¯ `zvµ[PÒ GÊu¨£mkÒÍx.

     E¸ 7.14  ö\ÆÁPö©õßÔß _ØÓÍÄ® £µ¨£ÍÄ®

  ö\¯Ø£õk

 }[PÒ E£÷¯õQUS® Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv 

÷©÷» E¸ 7.14 C¾ÒÍ £ozuõøÍz u¯õ›UPÄ®. A2 

©ØÖ® B2 P»[PÎß ö£Ö©õÚ[PøÍ ©õØÔ C ©ØÖ® D 

Á›PÎÀ Põmh¨£mkÒÍ `zvµ[PÎß ö£Ö÷£ÖPøÍ 

AÁuõÛUP. 

•UQ¯ SÔ¨¦

D2 P»zvØPõÚ `zvµ® D2=A2*B2 GÚ GÊxÁuß ‰»® Ax J¸ •P¨¦  

Aøh¯õÍ©õP ©õÔÚõ¾® Po¨¥k {PÇ©õmhõx (E¸ 7.15 I¨ £õºUP). 
GÚ÷Á, `zvµ® GÊx®÷£õx  ‘‘ = ” Aøh¯õÍzxUS Chx £UPzvÀ GxÄ® 

GÊuU Thõx. (E¸ 7.16 I¨ £õºUP).

     E¸  7.15  `zvµ® GÊx®

            ¤øÇ¯õÚ •øÓ

           E¸  7.16  `zvµ® GÊx®

                    \›¯õÚ •øÓ
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Euõµn® 2

¦zuPö©õßÔß Âø» ©ØÖ® ö£ß]ö»õßÔß Âø» Gß£ÁØøÓU Põmk® 

E¸ 7.17 CÀ Põmh¨£mkÒÍx. C[S £¯ß£kzu¨£mkÒÍ `zvµzvøÚ 

AÁuõÛUP.

  ö\¯Ø£õk
}[PÒ E£÷¯õQUS® Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv 

E¸ 7.17 CÀ EÒÍÁõÖ £ozuõÎøÚz u¯õ›UP. B1  ©ØÖ® 

B2 P»[PÎß ö£Ö©õÚ[PøÍ ©õØÖÁuß ‰»® B3, B4, 
B5, B6 BQ¯ P»[PÎÀ QøhUP¨ö£Ö® ö£Ö©õÚ[PøÍ 

AÁuõÛUP. 

Euõµn® 3

J¸ \xµ•Q°ß £UP® JßÔß }Í® uµ¨£k®÷£õx Auß ÷©Ø£µ¨£ÍøÁ²® 

PÚÁÍøÁ²® PõnÀ. (E¸ 7.18 I¨ £õºUP.)  

E¸ 7.18  \xµ•Q°ß £µ¨£ÍÄ® PÚÁÍÄ®

  ö\¯Ø£õk 

E¸ 7.18 C¾ÒÍ £ozuõÎøÚ }[PÒ £¯ß£kzx® Â›uõÒ 

ö©ßö£õ¸øÍ¨ £¯ß£kzv B1  P»zvß ö£Ö©õÚ[PøÍ 

©õØÔ B2, B3, B4 BQ¯ P»[PÎÀ SÔ¨¤h¨£mkÒÍ 

`zvµ[PÎß ö£Ö©õÚ[PøÍ  CÚ[PõsP.

E¸ 7.17 Âø»PøÍU PozuÀ

¦zuP® JßÔß Âø»

ö£ß]À JßÔß Âø»

¦zuP® JßÔÚx® ö£ß]À JßÔÚx® Âø»

‰ßÖ ¦zuP[PÎß Âø»

¦zuP® JßÔÚx® ö£ß]À JßÔÚx®

Âø»PÐUQøh°»õÚ Âzv¯õ\®

4 ¦zuP[PÎÚx® 2 ö£ß]ÀPÎÚx Âø»

\xµ•Q°ß J¸ £UP }Í®

\xµ•Q°ß J¸ £UP £µ¨£ÍÄ

\xµ•Q°ß •Ê ÷©Ø£µ¨£ÍÄ

\xµ•Q°ß PÚÁÍÄ
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               `zvµ®                  •iÄPÒ

=A1*B1-D2
=D1−C2/A2
=B3^C3−A3
=A1*C1/C3
=D2*C4*E1
=A3/B3+A2*D1
=A1+(B2*C2)−B3+C2/B2
=B2−B3+B1*(D1+D2^B1)
=A2^B3-C2+A3*(B3+C1)
=A3/C3*(D2*D1)
=D3/C3/B3*A3+B2
=(D3/(A1+B2))^C2

                                     AmhÁøn  7.8

SÔ¨¦ : 	P»•PÁ›ø¯¨   £¯ß£kzv    GÊu¨£mh    `zvµ[PÒ     ‰»® 

	 QøhUS® •iÄPÒ Ga\¢uº¨£zv¾® `zvµ[PøÍ GÊu¨ 

£¯ß£kzu¨£k® SÔ±kPÒ ©õØÓ¨£kÁuß ‰»® Âzv¯õ\¨ 

£kQßÓÚ. 

  ö\¯Ø£õk

	 R÷Ç Põmh¨£mkÒÍ £ozuõÎÀ  (E¸ 7.19) AmhÁøn 

7.7 CÀ SÔ¨¤h¨£mkÒÍ `zvµ[PøÍ¨ £¯ß£kzv AÁØÔß 

•ßÝ›ø©¨£i Po¨¥k ö\´x ö£Ó¨£k® ö£Ö©õÚ[PøÍ  

GÊxP.  

`zvµ® Âøh

=A1+B1 12
=C1+C2+C3	 17
=B2+C3+B3	 7
=A2*C1	 12
=C2/A2*D1 6
=B3^A2+D1 10

E¸ 7.19 uµÄPøÍ EÒÍhUQ¯ £ozuõÒ

    AmhÁøn  7.7
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 7.4  Pozu¾US \õº¦PøÍ¨ £¯ß£kzuÀ
	

	 uµÄPÎß AÍÄ AvP›US®÷£õx P»•PÁ›°øÚ ©õzvµ® £¯ß 

£kzva `zvµ[PøÍ Aø©¨£x PiÚ©õS®. AÆÁõÓõÚ \¢uº¨£[PÎÀ 

`zvµ[PÐUS¨ £v»õP \õº¦PøÍ¨ £¯ß£kzu •i²®. Â›uõÒ ö©ß 

ö£õ¸ÒPÎÀ  £À÷ÁÖ  Âu©õÚ Po¨¥kPøÍ ÷©ØöPõÒÍUTi¯uõP   \õº 

¦PÒ   Põn¨£kQßÓÚ.   AÁØÖÒ   AvP® £¯ß£õmiÀ EÒÍ Ai¨£øha 

\õº¦PÒ ]»ÁØøÓ AÔ¢xöPõÒ÷Áõ®. (AmhÁøn  7.9  I¨ £õºUP) 

\õº¦PÎß 

ö£¯º
     (Syntax) öuõh›¯À       £¯ß£õk

SUM =SUM (Number 1, Number 2......) P»Ãa]ÝÒ  EÒÍ ö£Ö©õ 

Ú[PÎß Tmkz öuõøPø¯  

AÔuÀ

AVERAGE	 =AVERAGE(Number1, Number 2.......)	 P»Ãa]ÝÒ  EÒÍ ö£Ö©õ 

Ú[PÎß \µõ\›°øÚ AÔuÀ

 MAX =MAX(Number1, Number 2.......) P»Ãa]ÝÒ  EÒÍ ö£Ö©õ 

Ú[PÎÀ ªP¨ ö£›¯ ö£Ö 

©õÚzøu AÔuÀ

 MIN =MIN(Number1, Number 2......) P»Ãa]ÝÒ  EÒÍ ö£Ö©õ 

Ú[PÎß ªPa]Ô¯ ö£Ö 

©õÚzøu AÔuÀ

COUNT =COUNT(Number 1, Number 2.......) P»Ãa]ÝÒ  EÒÍ ö£Ö©õ

Ú[PÎß P» GsoUøP 

°øÚ AÔuÀ

	

	 Euõµn©õP £ozuõöÍõßÔß uµÄPÍx TmkzöuõøP°øÚ 

Cµsk •øÓPÎÀ ö£ØÖUöPõÒÍ •i²®. R÷Ç \©ß£õk  CÀ CÚ[ 

Põmh¨£mkÒÍ     A1 P»® •uÀ   A10  P»®  Áøµ°»õÚ ö£Ö©õÚ[PÎÚx 

TmkzöuõøP°øÚ, P»•PÁ›ø¯ ©õzvµ® GÊxÁuß ‰»® ö£ØÖU 

öPõÒÍ»õ®. AÆÁõ÷Ó AÁØÔß TmkzöuõøP°øÚ  R÷Ç \©ß£õk 

CÀ Põmh¨£mkÒÍÁõÖ \õº¤øÚ¨ £¯ß£kzv²® ö£ØÖUöPõÒÍ»õ®. 

CøÁ CµsiÚx® ö£Ö÷£ÖPÒ \©ÚõS®. CÆÂµsk `zvµ[PøÍ²® 

J¨¤k®÷£õx P»Ãa_ AvP›US®÷£õx  CµshõÁuõPU Põmh¨£mkÒÍ              

\õº¤øÚ¨  £¯ß£kzxÁx C»SÁõÚuõP Aø©²®.

    AmhÁøn  7.9

1

2
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= A1+A2+A3+A4+A5+A6+A7+A8+A9+A10		     1

= SUM(A1:A10)						         
2

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10

	           =SUM( A1: A10)

    

	 J¸ \õº¤ÝÒ Em¦Szu¨£k®  P»Ãa\õÚx Bµ®£U P»•PÁ›ø¯²®  

CÖvU P»•PÁ›ø¯²®  öPõsi¸US®.

E¸ 7.20 ‰»® Põmh¨£mkÒÍ £ozuõÎÀ EÒÍ \õº¦PøÍ¨ £¯ß£kzv 

`zvµ[PøÍ Aø©¨÷£õ®.

\õº¤øÚ¨  £¯ß£kzu  •i²©õÚ £À÷ÁÖ \¢uº¨£[PøÍ¨ £ØÔ AÔ÷Áõ®

SUM \õº¦  ^AmhÁøn 7'10 £õºUP&

`zvµ® ÂÁµ® ö£Ö÷£Ö

= SUM (A1,B1,C1) A1, B1 ©ØÖ® C1 BQ¯ P»[PÍx ö£Ö 

©õÚ[PÎß TmkzöuõøP

        12

= SUM (A1:C1) A1  ©ØÖ® C1  Áøµ°»õÚ  P» CøhöÁÎ°À 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß Tmkz öuõøP

        12

= SUM (A1:C1,B2) A1 öuõhUP® C1  Áøµ°»õÚ  P» CøhöÁÎ°À 

Aø©¢xÒÍ  ö£Ö©õÚ[PÒ  ©ØÖ®   B2  P»z

vÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔß Tmkz 

öuõøP

        15

= SUM (B1:C2) B1 öuõhUP® C2 Áøµ°»õÚ P» CøhöÁÎ 

°À Aø©¢xÒÍ ö£Ö©õÚ[PÎß Tmkz 

öuõøP

        20

= SUM (A1:A3,C1:C3) A1 öuõhUP® A3 Áøµ²ÒÍx® C1 öuõhUP® 

C3 Áøµ²ÒÍx©õÚ  P» CøhöÁÎ°À Aø©¢ 

xÒÍ ö£Ö©õÚ[PÎß TmkzöuõøP

            35

E¸  7.20  £ozuõÒ

                                       AmhÁøn 7.10
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AVERAGE \õº¦ 

`zvµ® Â£µ® ö£Ö÷£Ö

= AVERAGE (A1,B1,C1) A1, B1 ©ØÖ® C1 BQ¯ P»[PÍx ö£Ö 

©õÚ[PÎß \µõ\›

           

4'00

= AVERAGE (A1:C1) A1  öuõhUP® C1  Áøµ°»õÚ  P»Cøh

öÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ[PÎß 

\µõ\›

           

4'00

= AVERAGE (A1:C1,B2) A1 öuõhUP® C1 Áøµ°»õÚ  P» Cøh 

öÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ[PÒ 

©ØÖ® B2 P»zvÀ EÒÍ ö£Ö©õÚ® 

BQ¯ÁØÔß \µõ\›

           

3'75

= AVERAGE (B1:C2) B1 öuõhUP®  C2 Áøµ°»õÚ  P»Cøh

öÁÎ°À Aø©¢xÒÍ ö£Ö©õ          

Ú[PÎß \µõ\›

           

5'00

= AVERAGE(A1:A3,C1:C3) A1 öuõhUP® A3 Áøµ²ÒÍx® C1 
öuõhUP® C3 Áøµ²ÒÍx©õÚ  P» 

CøhöÁÎ°À Aø©¢xÒÍ ö£Ö©õ 

Ú[PÎß \µõ\›

                
5.83

	                                  AmhÁøn 7.11				  

SÔ¨¦(	\µõ\›¨ ö£Ö©õÚ[PÐUPõÚ ö£Ö÷£ÖPÒ ö£¸®£õ¾® u\©uõÚ[

	 PÎÀ QøhUP¨ö£Ö®. A¨÷£ÖPøÍ EÒÍhUQ¯ P»Cøh 

öÁÎPÎÀ ÷uøÁ¯õÚ AÍÄ u\©uõÚ[PøÍ¨ ö£ØÖU öPõÒÍ  

AÁØøÓ ÁiÁø©¨¦ (Format) ö\´xöPõÒÍ ÷Ásk®.
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MAX \õº¦  

           `zvµ®                    Â£µ®  ö£Ö÷£Ö

= MAX(A1,B2,C1) A1, B2 ©ØÖ® C1 BQ¯ P»[PÎÀ EÒÍ ªP¨ 

ö£›¯ ö£Ö©õÚ®
       4

= MAX(A2:C2,B3) A2   öuõhUP®   C2   Áøµ°»õÚ    P»Cøh

öÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ[PÒ ©ØÖ® 

B3 P»zvÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔÀ 

ªP¨ ö£›¯ ö£Ö©õÚ®

       9

= MAX(A1:C1) A1 öuõhUP® C1  Áøµ°»õÚ  P» Cøh 

öÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ[PÎß 

ªP¨ ö£›¯ ö£Ö©õÚ®

       6

= MAX(A1,B1:C2) A1 ©ØÖ® B1 öuõhUP®  C2 Áøµ°»õÚ P» 

CøhöÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ 

[PÎß ªP¨ ö£›¯ ö£Ö©õÚ® 
       7

MIN \õº¦  

				  

        `zvµ®                 Â£µ®      ö£Ö÷£Ö

= MIN(A1,B2,C1) A1, B2 ©ØÖ® C1 BQ¯ P»[PÎÀ EÒÍ 

ªPa ]Ô¯ ö£Ö©õÚ®

        2

= MIN(A2:C2,B3) A2  öuõhUP®  C2  Áøµ°»õÚ  P»Cøh

öÁÎ°À Aø©¢xÒÍ ö£Ö©õÚ[PÒ 

©ØÖ® B3 P»zvÀ EÒÍ ö£Ö©õÚ® 

BQ¯ÁØÔÀ ªPa ]Ô¯ ö£Ö©õÚ®

        3

= MIN(A1:C1) A1 öuõhUP® C1 Áøµ°»õÚ  P»Cøh 

öÁÎ°À Aø©¢xÒÍ  ö£Ö©õÚ[PÎß 

ªPa ]Ô¯ ö£Ö©õÚ®

        2

= MIN(A1,B1:C2) A1 ©ØÖ® B1 öuõhUP® C2 Áøµ°»õÚ 

P» CøhöÁÎ°À Aø©¢xÒÍ ö£Ö 

©õÚ[PÎß ªPa  ]Ô¯ ö£Ö©õÚ® 

        2

                                         AmhÁøn 7.13

AmhÁøn  7.12
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 COUNT \õº¦ 

`zvµ® Â£µ® ö£Ö÷£Ö

= COUNT(A1,  B1) A1, B1 BQ¯ P»[PÎÀ EÒÍ 

ö£Ö©õÚ[PÎß GsoUøP

          2

= COUNT(A1:C1) A1 öuõhUP®  C1  Áøµ¯õÚ 

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          3

= COUNT(A1:A3) A1 öuõhUP®  A3  Áøµ°»õÚ 

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          3

= COUNT(A1:C1, B2) A1 öuõhUP®  C1 Áøµ¯õÚ 

P»[PÎ¾®  B2  P»zv¾® 

EÒÍ ö£Ö©õÚ[PÎß Gs 

oUøP

          4

= COUNT(B1:C3) B1 öuõhUP®  C3 Áøµ¯õÚ  

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          6

=COUNT(A1:A3, C1:C3) A1 öuõhUP®  A3 Áøµ¯õÚ 

P»[PÎÚx®  C1 öuõhUP®  C3  
Áøµ¯õÚ P»[PÎÚx® ö£Ö 

©õÚ[PÎß GsoUøP

          6

                                          AmhÁøn  7.14 	

	

	 £õh\õø»ö¯õßÔÀ uµ® 10 CÀ uPÁÀ öuõhº£õhÀ 

öuõÈÝm£¨ £õhzvøÚ PØS® BÖ ©õnÁºPÒ ö£ØÓ ¦ÒÎPÒ 7.21 
CÀ Põmh¨£mkÒÍÚ.			 

©õnÁºPÒ •u»õ® 
uÁøn

Cµshõ®
  uÁøn

‰ßÓõ®
  uÁøn

H. M. |õuß

T.  á¯ßuß

M.M. {¯õì

R. S©õ›

P.W. ÷uÂ

M.A.F ~ð»õ

ab

E¸  7.21

  ö\¯Ø£õk 
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\õº¦PøÍ ©õzvµ® £¯ß£kzv ¤ßÁ¸® ÂÚõUPÐUS Âøh u¸P.

^1& H. M |õuß ö£ØÖU öPõsh ¦ÒÎPÎß ö©õzuzvøÚ AÔ¯ E2 P»zvÝÒ 

Em¦Szu ÷Ási¯ \õº¤øÚU SÔ¨¤kP.

^2& T.  á¯¢uß ö£ØÖU öPõsh ¦ÒÎPÎß \µõ\›°øÚ AÔ¯ E3 P»zvÝÒ 

Em¦Szu ÷Ási¯ \õº¤øÚU SÔ¨¤kP.

^3&	 •u»õ® uÁøn°À ö£ØÖUöPõsh AvTi¯ ¦ÒÎ°øÚ AÔ¢x 

öPõÒÁuØöPÚ B8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

^4& 	Cµshõ® uÁøn¨ £Ÿmø\US ÷uõØÔ¯ ©õnÁºPÍx GsoUøPø¯ 

     AÔ¢u öPõÒÍ C8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

^5& ‰ßÓõ® uÁøn¨ £Ÿmø\°À ö£ØÖU öPõsh ªPU SøÓ¢u ¦ÒÎø¯ 

AÔÁuØS D8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

 7.5  £ozuõÎøÚ ÁiÁø©zuÀ

	 £ozuõÒ JßÔÝÒ EÒÍ GÊzxUPøÍ  ©ØÖ® ö£Ö©õÚ[PøÍ 

ÁiÁø©¨£uØS (Formatting) ÁiÁø©¨¦ E£Pµn¨ £møhø¯ AÀ»x 

P»ÁiÁø©¨¦¨ £møhø¯¨ £¯ß£kzu •i²®.

7.5.1  Microsoft Excel 2010 Cß P» ÁiÁø©¨¦ £møh 

21 3

1310 11 151412

5 6

9

7

8

4

 E¸ 7.22  Microsoft Excel 2010 P»ÁiÁø©¨¦¨ £møh

C» PmhøÍ ÂÁµ®

      1 Font P»zvÀ  £À÷ÁÖ  Âu©õÚ GÊzx 

ÁiÁ[PøÍ Aø©zuÀ

      2 Font Size P»zvÀ £À÷ÁÖ AÍÂ»õÚ GÊzx 

PøÍ  Aø©zuÀ

      3 Vertical Top Alignment P»zvÝÒ Auß Ea]°À {µ»õP 

Aø©zuÀ

      4 Vertical Middle Alignment P»zvÝÒ Auß ©zv°À {µ»õP 

Aø©zuÀ
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      5 Vertical Bottom Alignment 
P»zvÝÒ Auß Ai°À {µ»õP 

Aø©zuÀ

      6 Orientation P»zvß {ø»z ÷uõØÓ®

      7 Number Format
P»zvÝÒ   ö£Ö©õÚ[PøÍ 

JÊ[Pø©zuÀ

      8 Bold P»zvß EÒÍhUP[PøÍ ui¨£õUSuÀ

      9 Italic
P»zvß EÒÍhUP[PøÍ \õ´ÁõP 

Aø©zuÀ

     10 Underline
P»zvß EÒÍhUP[PÎß RÌU ÷Põi-

kuÀ

     11 Left Alignment
P»zvß EÒÍhUPzøu Chª¸¢x 

Á»©õP Aø©zuÀ 

     12 Center Alignment
P»zvß Chª¸¢x Á»©õP ©zv°À 

Aø©zuÀ  

     13 Right Alignment
P»zvß EÒÍhUPzøu Á»ª¸¢x 

Ch©õP  Aø©zuÀ  

     14 Increase decimal places 
ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

AvP›zuÀ

     15 Decreased  decimal places
ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

SøÓzuÀ

                                              AmhÁøn 7.15

7.5.2  LibreOffice  Calc Cß P» ÁiÁø©¨¦¨ £møh

8

3 4 5 61 2

7 9 10

 E¸ 7.23  LibreOffice  Calc 4.1 P» ÁiÁø©¨¦¨ £møh

C»UP® PmhøÍ ÂÁµ®

1 Font P»zvÀ  £À÷ÁÖ Âu©õÚ GÊzxPøÍU 

Aø©zuÀ

2 Font Size P»zvÀ £À÷ÁÖ AÍÂ»õÚ

GÊzxPøÍU Aø©zuÀ
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3 Bold P»zvß EÒÍhUP[PøÍz ui¨£õUSuÀ

4 Italic P»zvß EÒÍhUP[PøÍa \õ´ÁõP 

Aø©zuÀ

5 Underline P»zvß EÒÍhUP[PÎß RÌ ÷Põi-

kuÀ

6 Left Alignment P»zvß EÒÍhUPzøu Chª¸¢x 

Á»©õP CkuÀ 

7 Center Alignment P»zvß ©zv°À Aø©zuÀ 

8 Right Alignment P»zvß EÒÍhUPzøu Á»ª¸¢x 

Ch©õP  Aø©zuÀ 

9 Increase decimal places ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

AvP›zuÀ

10 Decreased  decimal 
places

ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

SøÓzuÀ

				      AmhÁøn 7.16

7.5.3  ö£Ö©õÚ[øÍ   ÁiÁø©¨£uØPõP  P»  •P¨¦PøÍ¨   

          £¯ß£kzuÀ 
	

J¸ P»® AÀ»x P»Ãa]øÚ ÁiÁø©¨£uØS P» ÁiÁø©¨¦ ö\õÀ»õhØ 

ö£miPøÍ¨ (Format Cells Dialog Box) £¯ß£kzu•i²®. 

    E¸ 7.24 P» ÁiÁø©¨¦ •P¨¦                   E¸ 7.25 P» ÁiÁø©¨¦ •P¨¦ 

Microsoft Office Excel 2010 CÀ 

Home Tab  → Number Group LibreOffice Calc CÀ

Format→Cells
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7.5.4  P»Ãa]À u\© GsPøÍ JÊ[Pø©zuÀ 

	 ö£Ö©õÚ[PøÍ ÁSUS®÷£õx £À÷ÁÖ Âu©õÚ u\© AÍÄPÎÀ 

ö£Ö÷£ÖPÒ QøhUS®. AÁØøÓ {ø»¯õÚ u\© ö£Ö©õÚzvÀ SÔ¨¤kuÀ 

÷Ásk®. E¸ 7.26 I¨ £õºUP'

             E¸ 7.26 Cµsk u\©  uõÚ[PÐUS ÁiÁø©zuÀ

ÁiÁø©UP

•ß

Cµsk u\© 

uõÚ[PÐUS 

ÁiÁø©zu ¤ß

	

	 ÷uøÁ¯õÚ u\©uõÚ[PøÍ¨ ö£ØÖUöPõÒÍ ¤ßÁ¸® ÁiÁø©¨ 

¤øÚU øP¯õÒP. 

7.5.5 P»Ãa]øÚ   •P¨¦   Aøh¯õÍ©õP  ÁiÁø©zuÀ

	 öuõø»÷£] C»UP® JßÔÀ 10 C»UP[PÒ Aø©¢v¸US®. GÛÝ®, 

CÆÂ»UP[PÎß Bµ®£zv¾ÒÍ §a]¯® (0) Â›uõÎÀ öuß£kÁvÀø». 

CuØSU Põµn® AuøÚ²® J¸ ö£Ö©õÚ©õP P¸xÁuõS®. GÚ÷Á 

öuõø»÷£] C»UP[PøÍ Em£kzu •ßÚº  E›¯ P»CøhöÁÎ°øÚ Text 
•øÓUS ©õØÖuÀ ÷Ásk® (E¸ 7.27 I²® E¸ 7.11 Cß D {µø»²® £õºUP).

Microsoft Office Excel  2010 CÀ

1' P» CøhöÁÎ°øÚ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US®  

   •P¨¤øÚ ö£ØÖUöPõÒÐuÀ

3'  Number Tab I öu›Ä ö\´uÀ  

4' Number I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P» CøhöÁÎ°øÚ öu›Ä   

   ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US®  

   •P¨¤øÚ ö£ØÖUöPõÒÐuÀ 

3' Numbers Tab I öu›Ä ö\´uÀ  

4' Number I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ
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E¸ 7.27 P»CøhöÁÎø¯ Text •øÓUS ©õØÖuÀ 

ö£Ö©õÚ[PÍõP Põn¨£hÀ ÁiÁø©¨¦US Em£kzv¯uß ¤ß

P»Ãaø\ Text •øÓUS ÁiÁø©UP ¤ßÁ¸©õÖ ö\¯Ø£hÄ®'

7.5.6  P»Ãa]øÚ  \uÃu[PÒ    öu›¯UTi¯ Âu©õP ÁiÁø©zuÀ          

	
	 J¸ ö£Ö©õÚzvøÚ CßöÚõ¸ ö£Ö©õÚzvÚõÀ ÁSzx¨ ö£Ö® 

ö£Ö©õÚzvøÚ \uÃuzvÀ (Percentage) PõmhUTi¯ Âu©õP ÁiÁø©UP 

÷Ásk®.   ¦zuP Pøhö¯õßÔß •u»õ® Põ»õskUPõÚ ©õuõ¢u Á¸©õÚ      

\uÃu® £ozuõÎÀ  Põmh¨£mkÒÍøu (E¸ 7.28 CÀ) Põn»õ®.

Microsoft Office Excel  2010 CÀ

1' P» CøhöÁÎ°øÚ öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   •P¨¤øÚ ö£ØÖUöPõÒÍÀ

3'  Number Tab I öu›Ä ö\´uÀ  

4' Text Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚzøu EÒÎhÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P» CøhöÁÎ°øÚ öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   •P¨¤øÚ¨ ö£ØÖU öPõÒÐuÀ 

3' Numbers Tab I öu›Ä ö\´uÀ  

4' Text  Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚzøu EÒÎhÀ

6' OK ö\´uÀ
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            E¸ 7.28 P»Ãa]øÚ \uÃu©õP ÁiÁø©zxU PõmkuÀ

P»Ãa]øÚ \uÃu©õP ÁiÁø©UP ¤ßÁ¸® £i•øÓ°À ö\¯Ø£kzxP.

Microsoft Office Excel CÀ

1' P» CøhöÁÎ°øÚz öu›Äö\´uÀ  

2' ö£Ö©õÚzvøÚ ÁiÁø©US® 

   •P¨¤øÚ¨ ö£ØÖUöPõÒÍÀ

3' Number Tab I öu›Äö\´uÀ  

4' Percentage I  öu›Äö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P» CøhöÁÎ°øÚz öu›Äö\´uÀ  

2' ö£Ö©õÚzvøÚ ÁiÁø©US® 

   •P¨¤øÚ¨ ö£ØÖUöPõÒÍÀ

3'  Numbers Tab I öu›Äö\´uÀ  

4' Percentage I  öu›Äö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

7.5.7  P»Ãa]øÚ  uºUPŸv¯õÚ   ö£Ö©õÚ©õP    ÁiÁø©zuÀ                                                                                                                  

	 Â›uõÒPÎÀ ªPa]Ô¯ uõÚ[PÒ •uÀ ªP¨ö£›¯ uõÚ[PøÍU 

ThU PnUQk® Á\vPÒ EÒÍÚ. AÆÁõÓõÚ ö£Ö©õÚ[PøÍ G©US Áõ]

zx ÂÍ[Q öPõÒÁuØS® AuøÚ •ßøÁ¨£uØS® •i¯õx GÛÝ®, 

AÔÂ¯À ö£Ö©õÚ©õP (Scientific) E¸ÁõUQ¯  ¤ßÚº \P» ö£Ö©õÚ[PÐ® 

J÷µ ÁiÁzvß RÌ Á¸ÁuÚõÀ AÁØøÓ Áõ]zx  ÂÍ[QU öPõÒÁuØS® 

•ßøÁ¨£uØS®  Á\v¯õP  Aø©²®. (E¸ 7.29 I £õºUPÄ®)

©õu® \®£Í® \uÃu®

áÚÁ›

ö£¨£µÁ›

©õºa

H¨¤µÀ
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E¸ 7.29 AÔÂ¯À ö£Ö©õÚ[PÒ 

Â£µ® ö£Ö©õÚ®
AÔÂ¯ÀŸv¯õÚ

ö£Ö©õÚ®

P»Ãa_UPøÍz AÔÂ¯À ö£Ö©õÚ[PÍõP ©õØÓ ¤ßÁ¸® £i•øÓPøÍU 

øP¯õÒP.

Microsoft Office Excel  CÀ

1' P»CøhöÁÎ°øÚ öu›Ä  ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   •P¨¤øÚ ö£ØÖUöPõÒÍÀ

3' Number Tab I öu›Ä ö\´uÀ  

4' Scientific I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»CøhöÁÎ°øÚ öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   •P¨¤øÚ ö£ØÖUöPõÒÍÀ

3'  Numbers Tab Iz öu›Ä ö\´uÀ  

4' Scientific Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

 

7.5.8  P»Ãa]À   vPvPøÍU  PõmhUTi¯  Âu©õP ÁiÁø©zuÀ        
	

	 J¸ PoÛz vPv°øÚ (Date) 5$19$2014 GÚU PõmiÚõÀ Auß ÂÍUP® 

2014  ÷© ©õu® 19 B® vPv¯õS®. Cx Aö©›UP •øÓ¯õS® (mm ©õu® dd 

vPv yyyy Á¸h®) Â›uõÒPÎÀ vPvPøÍ £À÷ÁÖ Âu[PÎÀ Põmh•i²®. 

E¸ 7.30 I¨ £õºUP.

	
    E¸ 7.30 vPv°øÚ¨ £À÷ÁÖ Âu[PÎÀ PõmkuÀ

vPvø¯U Põmk® £À÷ÁÖ •øÓPÒ

J¸ öµÓõ ø£ØÔøÚ ¤ØÖPÎÀ GÊxuÀ

                   ö|QÌÁmiß öPõÒÍÍÄ öµÓõ ø£ØÖPÎÀ
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Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPUTi¯ 

   •P¨¤øÚ¨ ö£ØÖUöPõÒÍÀ

3' Number Tab Iz öu›Äö\´uÀ  

4' Date Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

  Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   •P¨¤øÚ¨ ö£ØÖU öPõÒÍÀ

3'  Numbers Tab Iz öu›Äö´uÀ  

4' Date  Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

7.5.9 P»Ãa]À  ÷|µzøuU  PõmhUTi¯ Âu©õP   ÁiÁø©zuÀ  

	 PoÛ JßÔÀ ÷|µ® (Time) 10:35:53 AM GÚ  SÔzxU Põmh¨£k®. 

C[S  hh:mm:ss:AM/PM GÚ ö£õxÁõPU Põmh¨£k®. E¸ 7.31 I¨ £õºUP.  hh 

Gß£x ©ozv¯õ»zøu²® mm Gß£x {ªhzøu²® ss Gß£x ö\UPøÚ²® 

AM Gß£x •Ø£Pø»²® PM ¤Ø£Pø»²® SÔzx {ØQßÓx. 

E¸ 7.31 £À÷ÁÖ ÷|µ® Põmk® •øÓPÒ

÷|µzøu JÊ[PõP PõmkuÀ

Microsoft Office Excel  2010 CÀ

1' P»Ãa]ß öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   •P¨¤øÚ¨ ö£ØÖUöPõÒÍÀ

3' Number Tab Iz öu›Ä ö\´uÀ  

4' Time Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   •P¨¤øÚ¨ ö£ØÖUöPõÒÍÀ

3'  Numbers Tab I öu›Äö\´uÀ  

4' Time I öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ
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7.5.10  P»Ãa]À {v¨ ö£Ö©õÚ[PøÍ  ÁiÁø©zuÀ          

	 {v¨ ö£Ö©õÚ[PÐUS›¯ ^Currency& SÔ±kPøÍ ^$- öhõ»º, Rs - 
¹£õ& A¨ö£Ö©õÚzvß    •ßÚõÀ GÊu ÷Ásk®. E¸ 7.28 CÀ {øµ°øÚ¨ 

£õºUP.

P»Ãa_ JßÔÀ {v¨ö£Ö©õÚ[PøÍU PõmkÁuØS ¤ßÁ¸® £i•øÓø¯U 

øP¯õÒP.

Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2. ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   •P¨¤øÚ ö£ØÖU öPõÒÍÀ

3'  Number Tab I öu›Äö\´uÀ  

4' Currency I öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ 

   AÍÂøÚ  Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2. ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   •P¨¤øÚ ö£ØÖU öPõÒÍÀ

3' Numbers Tab Iz öu›Äö\´uÀ  

4' Currency Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ 

  AÍÂøÚ  Aø©zuÀ

6' OK ö\´uÀ

7.5.11  P»Ãa]¾ÒÍ ö£Ö©õÚ[PøÍ ÷|º£kzuÀ ^Alignment&  ö\´uÀ

	 P»[PÎÀ EÒÍ ö£Ö©õÚ[PøÍ   Chx, Á»x, ©zv GßÓÁõÖ ÷|º¨ 

£kzvU ^Alignment& öPõÒÍ»õ®.

	

          (Left Alignment)	     (Center Alignment)        (Right Alignment)
Chx ÷|º£kzuÀ          ©zv¯ ÷|º£kzuÀ      Á»x ÷|º£kzuÀ
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Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ

2' Format Celles dialog Box I ö£ØÖU 

   öPõÒP.

3'  Alignment Tab I öu›Äö\´uÀ.

4' Ch®, Á»®, ©zv Gß£ÁØÔÀ 

   JßøÓz öu›Ä ö\´P.

5' OK ö\´P.

LibreOffice Calc  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ

2' Format celles dialog Box I ö£ØÖU 

   öPõÒP.

3'  Alignment Tab I öu›Äö\´uÀ.

4' Ch®,Á»®,©zv Gß£ÁØÔÀ 

   JßøÓ öu›Äö\´P.

5' OK ö\´P.

ö\¯Ø£õk

ÁiÁø©zuÀ E£Pµn[PøÍ¨ £¯ß£kzv²® ̀ zvµ[PøÍ GÊv²®  

R÷Ç  E¸ 7.32  CÀ Põmh¨£mkÒÍ £ozuõÎøÚz u¯õ›UP'

E¸ 7.32  £À÷ÁÖ ÁiÁø©zuÀ •øÓPÐhß Ti¯ £ozuõÒ

1. 	A {øµUS® Cµshõ® {µ¾US•›¯ Cøn¨ø£a ö\´P.

2.  	CµshõÁx {µø» ui¨£õUP® (Bold)  ö\´P.

3. 	•u»õÁx Á›°¾ÒÍ uø»¨¦USU RÌU ÷PõikP. GÊzxUPÎß AÍøÁ 

(Font size) 10 BP ©õØÖP.

4. 	A3, A4, A5  P»[PøÍ \õ´ÁõP (Italic) ©õØÖP.

5.  	B6 P»zvØS áÚÁ› ©õu ö©õzuzvøÚ¨  ö£ØÖUöPõÒÍ `zvµ® 

JßÖUS›¯  SUM  \õº¤øÚ GÊxP.

6.  B7 P»zvØS áÚÁ›©õua \µõ\›ø¯¨ ö£ØÖUöPõÒÍ `zvµ® JßÖUS 

AVERAGE  \õº¤øÚ GÊxP.

7.	 ÷©÷» B6, B7 P»[PÎÀ EÒÍ `zvµ[PøÍ¨ ¤µvö\´x HøÚ¯ 

©õu[PÎß ö©õzuzøu²® \µõ\›ø¯²® PõsP.

8. 	E3  P»zvØS, P»[PÎß ö©õzuzøuU Põs£uØS  SUM  \õº¤øÚ GÊxP.

9. 	F3 P»zvØS, P»[PÎß  \µõ\›°øÚ Põs£uØS GÚ AVERAGE                           
\õº¤øÚ GÊxP.

10. ÷©÷» E3, F3 P»[PÎ¾ÒÍ `zvµ[PøÍ¨ ¤µvö\´x HøÚø¯ 

¤›ÄPÎß ö©õzuzøuø¯²® \µõ\›ø¯²® PõsP. 

£õh\õø» Áõ]P\õø» £¯ß£õk  (P.ö£õ.u E¯ºuµ ¤›ÄPÒ Ai¨£øh°À)

Pø»

  áÚÁ›  ö£¨µÁ›    ©õºa  ö©õzu®    \µõ\›

ÁºzuP®

ÂgbõÚ®

ö©õzu®

\µõ\›

¤›ÄPÒ
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 7.6  \õº£õÚ, \õº£ØÓ P»[PøÍ CÚ[PõnÀ

7.6.1  `zvµ® JßøÓ¨ ¤µvö\´uÀ

	      £õh\õø»ö¯õßÔÀ  uÁøn¨   £Ÿmø\   JßÖ  •iÁøh¢u ¤ßÚº                                                                                                                      

©õnÁºPÍx  ö©õzu¨ ¦ÒÎPÒ,  \µõ\› ÷£õßÓÁØøÓ   EÒÍhUQ¯  ¦ÒÎ¨

£iÁ[PøÍ¨  ÷£qÁx  ÁÇø©¯õS®.  GÛÝ®, C»zvµÛ¯À Â›uõøÍ¨

£¯ß£kzv ¦ÒÎ¨ £mi¯ø»z u¯õ›¨£x ªPÄ® £¯ÝÖv EÒÍ J¸ 

•øÓ¯õS®. GÊu¨£mh  `zvµ[PøÍ¨  ¤µvö\´x ªP C»SÁõP  Po¨     

¥kPøÍ ö\´¯ •i²®. £ozuõÒ JßÔß {µ¼ß«x AÀ»x {øµ°ß«x 

J¸ `zvµzøu¨ ¤µv±k ö\´Áx GÆÁõÖ Gß£øu CÛ |õ®  PÁÛ¨÷£õ®. 

7.6.2  P»zvß {µ¨¦¨ ¤i (Fill handle)

	 £ozuõÎÀ G¢uöÁõ¸ P»zv¾® Á»¨£UP RÌ ‰ø»°À EÒÍ ªPa 

]Ô¯ \xµ® {µ¨¦¨ ¤i (Fill handle) GÚ¨£k®. (E¸ 7'33 I¨ £õºUP.)

 E¸ 7.33 
{µ¨¦¨ ¤i

7.6.3  `zvµ[PøÍ¨ ¤µvö\´ÁuØöPÚ {µ¨¦¨ ¤i°øÚ¨ 

          £¯ß£kzuÀ

{µ¨¦¨ ¤i°øÚ¨ £¯ß£kzv `zvµ[PøÍ¨ ¤µvö\´ÁuØPõP 

¤ßÁ¸®  £i•øÓPøÍ¨ ¤ß£ØÖP. 

^1& `zvµ® Ah[Q²ÒÍ P»zvøÚz öu›uÀ

^2& P»zvß Á»¨£UP RÌ ‰ø»°À {µ¨¦¨ ¤i°øÚz öu›uÀ

^3& {µ¨¦¨ ¤i°øÚ ÷uøÁ¯õÚ P»zøu ÷|õUQ CÊzxa ö\À»À.
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7.6.4  `zvµ[PøÍ   ¤µvö\´ÁuØS  ¤µv  (Copy),  Jmk  (Paste)                                                    
          Gß£ÁØøÓ¨   £¯ß£kzuÀ.

	 Copy, Paste Gß£ÁØøÓU öPõsk ¤µvö\´ÁuØS ¤ßÁ¸® ÁÈ 

•øÓPøÍU øP¯õÒP.

^1&  `zvµ® EÒÍh[Q¯ P»zvøÚz öu›uÀ   

^2&	 Copy SÔ±miøÚ¨ ö£ØÖUöPõkzuÀ ^Ctrl + C&

^3&	 ¤µvö\´ÁuØS P» CøhöÁÎ°øÚz öu›uÀ

^4&	 Paste  SÔ±miøÚ¨ ö£ØÖUöPõkzuÀ ^Ctrl + V&

7.6.5  \õº£õÚ ©ØÖ® \õº£ØÓ P»[PøÍ¨ ö£ØÖU öPõkzuÀ

	 P»•PÁ›,  {µÀ GÊzxUPøÍ²® {øµ C»UP[PøÍ²® öPõsi¸US®. 

`zvµ® ‰»® AÆÁõÓõÚ P»•PÁ› JßÔøÚ ÷ukuÀ \õº£õÚ P» EÒÏk 

GÚ¨£k®. öhõ»º ^$& Aøh¯õÍzvøÚ :
· {øµ C»UPzvß •ß÷Ú CkÁuß ‰»® {µÀ \õº£ØÓ P» EÒÏk JßÖ®  

· {µÀ GÊzxPÎß •ß÷Ú CkÁuß ‰»® {µÀ \õº£ØÓ P» EÒÏk     

   JßÖ® 

· {øµ C»UP® ©ØÖ® {µÀ GÊzx BQ¯ÁØÖUS •ß÷Ú CkÁuß ‰»®   

   {øµ ©ØÖ® {µÀ \õº£ØÓ EÒÏk® JßÖ® QøhUQßÓx.

Euõµn®

H2	 - \õº£õÚ P»•PÁ› ^Relative cell reference&
H$2 	 - {øµ \õº£ØÓ P»•PÁ› ^Row absolute cell reference&
$H2	 - {µÀ \õº£ØÓ P»•PÁ› ^Column absolute cell reference&
$H$2	 - {øµ ©ØÖ® {µÀ \õº£ØÓ P»•PÁ› ^Row and column absolute cell 		
	    reference&

7.6.6  \õº£õÚ P»[PÒ

	 `zvµ® JßøÓ ¤µvö\´²®÷£õx AøÁ EÒÍhUS® P»•PÁ›°Úx 

{µÀ GÊzxUPÒ, {øµ C»UP[PÒ ©õÖ£k©õ°ß AU P»•PÁ›PÒ \õº£õÚ 

P» •PÁ›PÒ (Relative cell reference) GÚ¨£k®.  
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Euõµn®

	 C1 P»zvÝÒ GÊu¨£mkÒÍ  = A1+B1 GßÝ® `zvµ®  C 

{µ¼ÞhõPÄ® •u»õÁx {øµ°ÞhõP Qøh¯õPÄ® ¤µv ö\´¯¨£k®÷£õx 

R÷Ç EÒÍ E¸  7.34 CÀ Põmh¨£mkÒÍ Âu©õP P»•PÁ› \õº£õP 

Âzv¯õ\¨£k® Cuß £i   A1 ©ØÖ® B1 BQ¯ P»•PÁ›PÒ \õº¦ EÒÏkPÒ 

GÚ AøÇUP¨£k®'

7.6.7  {øµ \õº£ØÓ P»•PÁ›
 

	 `zvµ® JßÖ J¸ Á›°ÞhõP¨ ¤µvö\´¯¨£k®÷£õx P» 

•PÁ›PÎÀ {øµ C»UP[PÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ {øµ \õº 

£ØÓ P»•PÁ›PÒ GÚ¨£k®.  ^Row absolute cell reference& 

Euõµn® 

	 C1 P»zvÝÒ GÊu¨£mkÒÍ = A$1+B$1 GßÝ® `zvµ® C 
{µ¼ÞhõPÄ® •u»õÁx Á›°ÞhõP Qøh¯õPÄ® ¤µv ö\´¯¨£k®÷£õx 

E¸   7'35 Põmh¨£mkÒÍ Âu©õP P»•PÁ› {µ¼ÞhõP  R÷Ç ©õØÓ©øh¯ 

©õmhõx. Auß£i   A$1 ©ØÖ® B$1 BQ¯ P» •PÁ›PÒ {øµ \õº£ØÓ P» 

•PÁ›PÒ  GÚ AøÇUP¨£k®.

E¸ 7.34   \õº¦ EÒÏkPÒ öPõsh £ozuõÒ 

{øµ ©õØÓ©øh²®'

{µÀ 

©õØÓ©øh²®

{øµ°ÞhõP ¤µv ö\´¯¨£k® ÷£õx 

P»•PÁ› Âzv¯õ\¨£k®.

{µ¼ÞhõP ¤µv ö\´¯¨£k® 

÷£õx P»•PÁ› Âzv¯õ\¨£hõx.                                                             E¸ 7.35
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Euõµn® 2

	 J¸  ö£ß]¼ß Âø» öPõkUP¨£mkÒÍ {øµ°À £» ö£ß]ÀPÎÚx 

Âø»°øÚ AÔuÀ R÷Ç E¸ 7.36 ‰»® Põmh¨£mkÒÍx.

ö£ß]ÀPÎß GsoUøP

                                                         E¸ 7.36

	 ÷©÷» EÒÍ £ozuõÎÀ  C {µ¼ÞhõP ö£ß]ÀPÎß AÍÄUSa \õº 

£õP J¸ ö£Ö©v°øÚU Po¨¥k ö\´¯   C2 P»zvÝÒ GÊu¨£h÷Ási¯ 

`zvµ®  =A2*B2 BS®. CuøÚ  C2 {µ¼ß FhõP R÷Ç CÊ¨£uß ‰»® 

ö£ß]¼ß AÍÄPÎß ö£Ö©õÚzøu AÔ¯ •i¯õx.

 

	 `zvµzvøÚ¨ ¤µv ö\´²®÷£õx A2 Âu©õP÷Á A3, A4, A5 ÷£õßÓ 

ÁõÖ \õº£õP ©õØÓ[PøÍ HØ£kzu ÷Ásk® GÛÝ® \P» \¢uº¨£[PÎ¾®  

B2  P»zvß  `zvµ®  ©õÓõv¸zuÀ ÷Ásk®. P»zvÝÒ GÊu¨£h ÷Ás 

i¯ `zvµ®  =A2*B$2 BS®.

7.6.8  {µÀ \õº£ØÓ P»•PÁ› 

	 {µ¼ÞhõP J¸ ̀ zvµzvøÚ¨ ¤µvö\´²®÷£õx ̀ zvµ® Ah[Q²ÒÍ 

P»•PÁ›PÍx {µÀ GÊzxUPÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ {µÀ         

\õº£ØÓ P»•PÁ› GÚ¨£k®. (Column absolute cell reference) 

Euõµn® 1  

	 C1 P»zvÝÒ GÊu¨£mkÒÍ  = $A1+$B1 GßÝ® `zvµ® R÷Ç 

EÒÍ •u»õÁx Á›°ÞhõP SÖUPõPÄ® ¤µv ö\´²®÷£õx R÷Ç E¸  7'37 

CÀ SÔ¨¤h¨£mkÒÍ Âu©õP P»•PÁ› {µ¼ÞhõP R÷Ç ©õØÓ©øh²®. 

GÛÝ®, P»•Á›PÍx {µÀ GÊzxPÒ Á›PÎß «x ©õØÓ©øh¯õx. Auß£i   

$A1 ©ØÖ®  $B1  BQ¯ P»•PÁ›PÒ {µÀ\õº£ØÓ  P» EÒÏkPÒ GßÖ 

AøÇUP¨£k®.

J¸ ö£ß]¼ß Âø»     ¹. TmkzöuõøP    ¹.
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Euõµn®  

	 R÷Ç öPõkUP¨£mkÒÍ  7'38 £ozuõÎß ‰ßÓõÁx {µ¼ÞhõP 

JÆöÁõ¸ KÁº •iÂ¾® ö£ØÖU öPõÒÍ¨£mh ö©õzu Kmh[PøÍ AÔ¢x 

öPõÒÁuØS ÷uøÁ¯õÚ `zvµ®  =SUM($B2:B2& BS®.

E¸ 7.38 {µÀ \õº£ØÓ P» EÒÏkPÐhß Ti¯ £ozuõÒ

‰ßÓõÁx {øµ°ß FhõP ¤µv ö\´¯¨£k®÷£õx R÷Ç E¸ 7.39 EÒÍ 

Âu©õPU Põn¨£k®.

E¸ 7.39 {µÀ \õº£ØÓ P» EÒÏkPÐhß Ti¯ £ozuõÒ

7.6.9  {øµ ©ØÖ® {µÀ \õº£ØÓ P»•PÁ›PÒ

	 `zvµ® JßÔøÚ J¸ {øµ°ÞhõP¨ ¤µvö\´²®÷£õx `zvµzvÀ 

Ah[Q²ÒÍ P»•PÁ›°ÞhõP C»UP[PÒ ©õÓõÂiß ©ØÖ® J¸ {øµ°ß 

FhõP¨ ¤µvö\´²®÷£õx `zvµzvÝÒ Ah[Q²ÒÍ P»•PÁ›PÍx {øµ 

GÊzxUPÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ {øµ ©ØÖ® {µÀ \õº£ØÓ 

P»•PÁ›PÒ GÚ¨£k®. (Row and Column absolute cell Reference)

KÁº GsoUøP

ö£ØÓ Kmh[PÒ

TmkzöuõøP

{µÀ GÊzxUPÒ ©õØÓ©øh¯õx.

{øµ GÊzxUPÒ ©õØÓ 

©øh²®.

E¸ 7.37 {µÀ \õº£ØÓ P» EÒÏkPÐhß Ti¯ £ozuõÒ

KÁº GsoUøP

ö£ØÓ Kmh[PÒ

TmkzöuõøP
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Euõµn® 1 
	 C1 P»zvÝÒ GÊu¨£mkÒÍ = $A $1  +  $B $1 ̀ zvµzvøÚ   C  {µ¼ÞhõP  

R÷Ç²® •u»õÁx {øµ°ÞhõPU SÖUPõPÄ® ¤µvö\´²®÷£õx R÷Ç E¸ 
7.40 Cß £i P»•PÁ› Âzv¯õ\¨£h©õmhõx

{øµ GÊzxPÒ ©õØÓ©øh¯õx.

{µÀ GÊzxPÒ 

©õØÓ©øh¯õx.

E¸ 7.40 {µÀ ©ØÖ® {øµ \õº£ØÓ P»•PÁ›PÐhß 

      Ti¯ `zvµ[PÒ EÒÍhUQ¯ £ozuõÒ

Auß£i {øµ ©ØÖ® {µÀ \õº£ØÓ P»•PÁ›PøÍU öPõsh `zvµ® Jß 

ÔøÚ {øµ AÀ»x {µÀ FhõP ¤µv ö\´²®÷£õx `zvµzvß P»•PÁ›PÒ 

©õÓõx.

Euõµn® 2
	 R÷Ç öPõkUP¨£mkÒÍ E¸ 7.41 £ozuõÎÀ D4 •uÀ I 4 Áøµ ¦z 

uP[PÎß Âø»²® C5 •uÀ C10 Áøµ  h]ßPÐUPõÚ  Âø»²® AÔ¯ 

÷Ási²ÒÍx. C1 P»zxUS J¸ ¦zuPzvß Âø»°øÚ Em¦Szv¯ Eh÷Ú 

AuØS›¯ Âø»²® öu›¯UTi¯  Âu©õP ö£õ¸zu©õÚ  `zvµzvøÚ  

GÊx÷Áõ®. `zvµzvÝÒ C1 P»•PÁ›  \õº£ØÓuõP C¸zuÀ ÷Ásk®. 

AuØSU Põµn® `zvµ® 4 BÁx {øµ°ÞhõPÄ®  C {µ¿hõPÄ® ¤µv 

ö\´¯¨£k®÷£õx `zvµzvÝÒ C1 ©õÓUThõx Gß£uõS®. GÚ÷Á E›¯ 

`zvµzvÝÒ  $C$1 GÚ Em¦Szu¨£k®.

 

E¸ 7'41 {øµ ©ØÖ® {µÀ \õº£ØÓ P» EÒÏk 

¦zuPzvß Âø»

Âø»

¦zuP[PÎß GsoUøP

h
]

ß
P
Î

ß
 

G
s

o
U
ø

P
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  ö\¯Ø£õk

1'  R÷Ç öPõkUP¨£mkÒÍ `zvµ[PøÍ {µÀPÐhÚõPÄ® {øµPÐ

    hÚõPÄ® ¤µvö\´²®÷£õx  P»[PÎÀ  C¯À£õP÷Á  HØ£k® 

    öÁÎ¨£õkPøÍ GÊxP.

         

2. \õº£õÚ ©ØÖ® \õº£ØÓ P»•PÁ›PÎøh÷¯ EÒÍ Âzv¯õ\zøu GÊxP.

        E¸  7.42
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7.7  Â›uõÒPøÍ¨ £¯ß£kzv Áøµ¦PøÍz u¯õ›zuÀ

	 GsPÎß ‰»® uµÄPøÍ •ßøÁUS®÷£õx AÁØøÓ J¨¤mk 

÷|õUSuÀ, £S¨£õ´Ä ö\´uÀ, ÂÍ[QU öPõÒÐuÀ ©ØÖ® •ßøÁzuÀ 

BQ¯Ú C»SÁõÚußÖ. BÚõÀ, Á›¨£h® ‰»® uµÄPøÍ •ßøÁU 

S®÷£õx ÷©ØTÔ¯ ¤µa\øÚPÒ uÂºUP¨£mk C»SÁõUP¨£kQßÓÚ.

CuØöPÚ Â›uõÒ ö©ßö£õ¸ÒPøÍ GÆÁõÖ £¯ß£kzxÁx Gß£øu 

AÁuõÛ¨÷£õ®.

Áøµ¦PÎß ÁøPPøÍ AÔ¢xöPõÒ÷Áõ®.

	 		

  Áøµ¦PÎß ÁøPPÒ    uÍU÷Põ»® £¯ß£õk

{µÀ Áøµ¦ (Column 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

•øÓ°À £S¨£õ´Ä 

ö\´¯ •i²®.

\»õøP Áøµ¦ (Bar 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

•øÓ°À £S¨£õ´Ä 

ö\´¯ •i²®.

÷Põmk Áøµ¦ (Line 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

•øÓ°À £S¨£õ´Ä 

ö\´¯ •i²®.

Ámh Áøµ¦   (Pie 
Chart)

£À÷ÁÖ uµÄPøÍ 

ÂQuõ\õµ •øÓ°À 

£S¨£õ´Ä ö\´¯ 

•i²®

XY ]uÓÀ Áøµ¦ (XY 
Scatter Chart)

P»¨£h©õÚ uµÄPøÍ 

J¨¤mk AÔ¯ •i²®

                                            AmhÁøn 7.17  Áøµ¦ ÁøPPÒ

E¸  7'43  Áøµ¦UPõÚ ¦ÒÎ  ÂÁµ[PÐhß Ti¯ £ozuõÒ

  ö\¯Ø£õk

AmhÁøn 7'17 CÀ Põmh¨£mkÒÍ JÆöÁõ¸ Áøµ¦US® ö£õ¸z 

u©õÚ  Euõµn[PÒ CÆÂµsøhz u¸P. 

ö£¯º

ÂPõè

A«º

ìjÁß

Ag\Úõ

|ì›¯õ

ì÷Áuõ

Pou® ÂgbõÚ® B[Q»® Áµ»õÖ uªÌ TmkzöuõøP
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Áøµ¦PøÍz u¯õ›UP ¤ßÁ¸® £i•øÓPøÍU øP¯õÒP.

Áøµ¦US uø»¨¦ JßÔøÚ ÁÇ[P ¤ßÁ¸® £i•øÓ°øÚU øP¯õÒP.

Áøµ¤À GÊzxUPøÍ¨ ö£¯›h ¤ßÁ¸® £i•øÓ°øÚU øP¯õÒP.

Microsoft Office Excel 2010 CÀ

1. uµÄ CøhöÁÎPøÍ öu›uÀ

   ( A1 : F3)
2. Insert → Chart
3. Áøµ¦ ÁøPPøÍ öu›uÀ

4. ö£õ¸zu©õÚ Áøµ¤øÚ 

   öu›uÀ

LibreOffice Calc 4.1 CÀ

1. uµÄ CøhöÁÎPøÍ öu›uÀ

    ( A1 : F3)
2. Insert → Chart
3. Áøµ¦ ÁøPPøÍ öu›uÀ

4. ö£õ¸zu©õÚ Áøµ¤øÚ  

   öu›uÀ

5. Finish ö£õzuõøÚ ö\¯Ø£kzuÀ

Microsoft Office Excel 2010 CÀ

Áøµ¤øÚz öu›uÀ

Layout →  Chart Title → Above 
chart
uø»¨¤øÚ umha_a ö\´P.

LibreOffice Calc 4.1 CÀ

Áøµ¤øÚz öu›uÀ

Insert →  Title
uø»¨¤øÚ umha_a ö\´x 

Ok ö\´uÀ.

Microsoft Office Excel 2010 CÀ

1. Áøµ¤øÚz öu›uÀ

2. Layout → Axis Title
3. Axis Type ( Vertical or Horizontal) 
   GÊzxPøÍ¨ ö£¯›kuÀ 

LibreOffice Calc 4.1 CÀ

1. Áøµ¤øÚz öu›uÀ

2. Insert →  Chart
3. GÊzxPøÍ¨ ö£¯›kuÀ

4. Ok ö\´uÀ
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©õnÁº ö£ØÓ ¦ÒÎPøÍ Ámh Áøµ¤À Em¦Szx÷Áõ®.

  

Microsoft Office Excel 2010 CÀ

1.uµÄ CøhöÁÎ 

 A1: A7 ©ØÖ® G1:G7     

CøhöÁÎPøÍz öu›Äö\´P.

2. Insert → Chart →  Pie chart 
 

LibreOffice Calc 4.1 CÀ

1.  uµÄ   CøhöÁÎ   	       

   A1:A7 ©ØÖ®  G1: G7   

   CøhöÁÎPøÍz öu›Ä   

   ö\´P.

2. Insert → Chart →  Pie chart

      
ÂPõè A«º ìjÁß Ag\Úõ |ì›¯õ ì÷Áuõ

ÂPõè A«º ìjÁß Ag\Úõ |ì›¯õ ì÷Áuõ

Pou®

ÂgbõÚ®

B[Q»®

Áµ»õÖ

uªÌ

¦ÒÎPÒ

uµ® 10 ©õnÁºPÒ £Ÿmø\ö¯õßÔÀ ö£ØÓ ¦ÒÎPÒ

ö£¯ºPÒ

E¸  7.45

E¸  7.44
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Euõµn®   Y= X2 - 5X - 3  C¸£ia \©ß£õmiØPø©¯ Áøµø£z u¯õ›zuÀ

Pmh® :1   £ozuõÎÀ  Põmh¨£mkÒÍÁõÖ  x  CØS  - 2  •uÀ  7  Áøµ  

               ö£Ö©õÚ[PøÍ Em¦SzxP. 

Pmh® : 2  B2 P»zxUS ¤ßÁ¸® `zvµzvøÚ Em¦SzxP = B1 ^ 2 - 5 * B1 - 3
Pmh® : 3   B2 P»zvÝÒ Em¦Szv¯ `zvµzvøÚ K2 P»® Áøµ°À ¤µv 		

	       ö\´P.  
Pmh® : 4   uµÄ CøhöÁÎ¯õP A1 : K2 CøhöÁÎ°øÚz öu›Äö\´P.

Pmh® : 5   Insert → Chart → XY scatter

E¸   7.47

E¸ 7.46
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£°Ø]

¤ßÁ¸® £ozuõøÍ¨ £¯ß£kzv R÷Ç EÒÍ ÂÚõUPÐUS Âøh u¸P'

1) 	 2, 6, 10, 14 GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

2) 	 9, 10, 11, 12 GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

3)	 6, 7,  8, 9, 10, 11, 12   GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

4) 	 A1 •uÀ  A4 Áøµ°»õÚ ö£Ö©õÚ[PÎß TmkzöuõøP°øÚ A5 CÀ 

ö£ØÖUöPõÒÁuØS P»•PÁ›°øÚ ©mk® £¯ß£kzxP.

5) 	 A3  •uÀ  D3  Áøµ°»õÚ  ö£Ö©õÚ[PÎß    TmkzöuõøP°øÚ    E3 	

P»zvÝÒ  ö£ØÖUöPõÒÍ¨ ö£õ¸zu©õÚ `zvµzvøÚa  \õº¤øÚ¨ 

£¯ß £kzv GÊxP.

6) 	 E3 CÀ EÒÍ `zvµzvøÚ  E4 US ¤µvö\´²® •øÓ°øÚU SÔ¨¤kP.

7) 	 E5   P»zxUS  A1   •uÀ   D4  Áøµ°À   \µõ\›¨   ö£Ö©õÚzvøÚ  ö£ØÖU  

öPõÒÁuØS AÁ]¯©õÚ `zvµzvøÚ \õºö£õßÔøÚ¨ £¯ß£kzv 

GÊxP.

E¸  7.48
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ö\¯Ø£õk                                                  

Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv ¤ßÁ¸® £ozuõÎøÚ Aø©UP. 

£Ÿmø\USz ÷uõØÓõu ©õnÁºPÐUS ab GÚ SÔUP¨£mkÒÍx.

µ®¯õ

AßÁº

÷Áo

öá¯¢v

{íõµõ

£õ¦

Pou® ÂgbõÚ® B[Q»® Áµ»õÖ uªÌ

\õº¦ JßÔøÚ¨ £¯ß£kzv E›¯ `zvµ[PøÍ Aø©USP.

1) µ®¯õ ö£ØÖUöPõsh ¦ÒÎPÎß  ö©õzuzvøÚ AÔÁuØS ö£õ¸zu©õÚ  

`zvµzvøÚ G2 P»zvÝÒ Em¦SzxP.

2) µ®¯õ ö£ØÖUöPõsh ¦ÒÎPÎß \µõ\›°øÚU Po¨£uØS ö£õ¸zu©õÚ    

   `zvµzvøÚ  H2 P»zvÝÒ Em¦SzxP. 

3) Pou¨ £õhzvÀ ©õnÁºPÒ ö£ØÖÒÍ ¦ÒÎPÎÀ Av Ti¯ ¦ÒÎ°øÚ 	

   ÷uº¢öukUP ö£õ¸zu©õÚ `zvµzvøÚ B9  P»zvÝÒ Em¦SzxP.

4) ©õnÁºPÒ JÆöÁõ¸ £õhzv¾® ö£ØÖÒÍ ªPUSøÓ¢u ¦ÒÎPøÍ 

   AÔ¢x öPõÒÁuØS ö£õ¸zu©õÚ ̀ zvµzvøÚ B10 P»zvÝÒ Em¦SzxP.

5) JÆöÁõ¸ £õhzxUS® ÷uõØÔ¯ ©õnÁºPÎß GsoUøP°øÚ AÔ¢x 

   öPõÒÁuØS ö£õ¸zu©õÚ `zvµzvøÚ B11 P»zvÝÒ Em¦SzxP.

6) JÆöÁõ¸ £õhzv¾® ©õnÁº ö£ØÖÒÍ \µõ\› ¦ÒÎPøÍ AÔ¢x 

   öPõÒÁuØS ö£õ¸zu©õÚ `zvµzvøÚ B12 P»zvÝÒ Em¦SzxP.

E¸  7.49
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ö£õÈ¨¦

²   {µÀPÒ (Columns) ©ØÖ® {øµPÒ (Rows)  GÚ  Aø©¢xÒÍ  P»z öuõSv°ß  

‰»® £ozuõÒ  (Work Sheet) Aø©UP¨£mkÒÍx.

²		 £ozuõÎß {µÀPÒ B[Q» ÷£öµÊzvß ‰»©õP÷Áõ GÊzxzöuõSv 

‰»©õP÷Áõ SÔUP¨£k®.

² 	 £ozuõÎß {øµPÒ C»UP[PÍõÀ ö£¯º SÔUP¨£k®.

² •u¼À {µÀPÎß GÊzxUPøÍ²® Akzu {øµPÎß C»UP[PøÍ²® 

Em¦Szv P»zxUPõÚ ö£¯º SÔ¨¤h¨£k®. Ax P»•PÁ› GÚ¨£k®.

² EÒÍhUP® •P¨¦ Aøh¯õÍ® (Label), ö£Ö©õÚ® (Values) AÀ»x 

`zvµ[PÒ (Formula), ÷£õßÓÁØÔÀ HuõÁx JßÔøÚU öPõsi¸US®.

²	 `zvµ® (=) \©ß Aøh¯õÍzøu Bµ®£©õPU öPõsk Aø©²®.

²	 Poua ö\´øPPÐUS (Operators) •ßÝ›ø© JÊ[S EÒÍx.

²	 `zvµ[PøÍ GÊu P»•PÁ› C¯UPUSÔ ©ØÖ® \õº¦ Gß£Ú 			

£¯ß£kzu¨£k®.

²	 `zvµ® JßÔøÚ C»SÁõP¨ ¤µvö\´ÁuØS {µ¨¦¨ ¤i°øÚ¨ (Fill 

handle) £¯ß£kzu»õ®. 

²	 \õº¦U P» EÒÏmiøÚ JßÔøÚ (Relative Cell Reference) •ØÖÖ ö\´ÁuØS  

(Absolute) öhõ»º Aøh¯õÍ® ($)  £¯ß£kzu¨£k®.

² 	 uµÄPøÍ¨ ¦ÒÎÂÁµ Ai¨£øh°À ÂÍUSÁøu Âh Áøµ¦PÒ FhõP 

ÂÍUSÁx C»SÁõÚuõS®.


